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1 关于本手册 

1.1 手册内容 
本手册以 MIPI 设计为例，以用户角度介绍 Gowin 云源软件的使用，旨

在帮助用户快速熟悉 Gowin 云源软件的使用流程，提高设计效率。 

1.2 相关文档 

通过登录高云半导体网站 www.gowinsemi.com.cn 可下载、查看以下相

关文档： 

 SUG100, Gowin 云源软件用户指南 

 SUG935, Gowin 设计物理约束指南 

 SUG101, Gowin 设计时序约束指南 

 SUG114, Gowin 在线逻辑分析仪用户指南 

 SUG282, Gowin 功耗分析工具用户指南 

 SUG502, Gowin Programmer 用户指南 

 SUG550，GowinSynthesis 用户指南 

1.3 术语、缩略语 
本手册中的相关术语、缩略语及相关释义如表 1-1 所示。 

表 1-1 术语、缩略语 

术语、缩略语 全称 含义 

PnR Place & Route 布局布线 

GAO Gowin Analyzer Oscilloscope 在线逻辑分析仪 

GPA Gowin Power Analyzer 功耗分析工具 

http://www.gowinsemi.com.cn/down.aspx?FId=n14:14:26
http://cdn.gowinsemi.com.cn/SUG100.pdf
http://cdn.gowinsemi.com.cn/SUG935.pdf
http://cdn.gowinsemi.com.cn/SUG101.pdf
http://cdn.gowinsemi.com.cn/SUG114.pdf
http://cdn.gowinsemi.com.cn/SUG282.pdf
http://cdn.gowinsemi.com.cn/SUG502.pdf
http://cdn.gowinsemi.com.cn/SUG550.pdf
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1.4 技术支持与反馈 

高云半导体提供全方位技术支持，在使用过程中如有任何疑问或建议，

可直接与公司联系： 

网址：www.gowinsemi.com.cn 

E-mail：support@gowinsemi.com 

Tel：+86 755 8262 0391 

http://www.gowinsemi.com.cn/
mailto:support@gowinsemi.com
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2 简介 

2.1 设计流程简介 

Gowin 云源软件支持 Windows 和 Linux 两个版本，支持界面模式和命令

行模式运行，本手册以 Windows10 版本、界面运行、MIPI 设计为例，介绍

Gowin 云源软件的快速入门方法。 

整个设计流程采用 Synplify Pro 工具综合，FloorPlanner 工具添加物理

约束和时序优化，Timing Constraints Editor 添加时序约束，GAO 工具添加

GAO 配置文件和采集数据，GPA 功耗分析工具添加 GPA 配置文件，

Programmer 工具进行比特流下载。 

2.2 快速入门设计简介 

高云 MIPI D-PHY TX RX IP 应用于串行显示接口和串行摄像头接口中，

用于接收或发送图像或视频数据，MIPI D-PHY 为其提供了在物理层上的定

义。 

整个设计集成了 MIPI RX 和 MIPI TX 两个 IP，通过 ROM 为 MIPI TX 提

供数据，MIPI TX 发送数据，MIPI RX 接收数据，最终使用 GAO 采集 MIPI RX

接收的数据，验证 MIPI RX 和 MIPI TX 的正确性，整体设计框图如图 2-1 所

示。 

图 2-1 MIPI 设计整体框图 

MIPI TXMIPI TX MIPI RXMIPI RXROMROM

Clock Lane

Data Lane0

Data Lane1

Data Lane2

Data Lane3

GAOGAO
Data Data
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3 快速入门 

3.1 创建工程 

3.1.1 新建工程 

打开 Gowin 云源软件，单击 Start Page 界面上“Quick Start > New 

Project”新建一个工程，工程名称为 MIPI_RX_TX，器件选择如图 3-1 所示： 

 Series：GW1N 

 Device：GW1N-9 

 Package：PBGA256 

 Speed：C6/I5 

 Part Number：GW1N-LV9PG256C6/I5 

点击“Next”，直至工程创建完成。新建工程的详细步骤请参考SUG100，

Gowin 云源软件用户指南。 

图 3-1 新建工程 

 

 

工程创建完成之后，在工程创建路径生成 impl 和 src 文件夹，如图 3-2

所示，其中，impl 用于放置综合后和布局布线后的文件，src 用于放置源文

http://cdn.gowinsemi.com.cn/SUG100.pdf
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件。 

图 3-2 工程目录 

 

3.1.2 生成 MIPI D-PHY IP 

通过选择菜单栏“Tools > IP Core Generator” 打开 IP Core Generator

界面，双击 Interface and Interconnect 将其展开，双击 MIPI RX 打开 IP 

Customization 界面，根据需要选择配置，本设计 MIPI RX 配置如图 3-3 所

示，完成配置选择之后，点击“OK”，即可生成 MIPI RX 的 IP。 

图 3-3 MIPI RX 配置 

 

 

IP 生成之后，在 IP 创建路径生成 IP 设计文件及仿真所需文件，如图 3-4

所示： 

 .v 文件为 IP 设计文件，其为加密形式； 

 _tmp.v 文件为 IP 设计模板文件，为用户提供 IP 设计使用模板； 

 .vo 文件为 IP 仿真模型文件，其为明文形式，可用于仿真； 

 .ipc 文件为 IP 配置文件，用户可加载该文件修改配置； 
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 temp 文件夹包含生成 IP 所需的文件； 

 doc、model、sim 和 tb 文件夹包含仿真所需文件，分别为说明文档、仿

真模型、仿真脚本和 testbench。 

注！ 

目前有些 IP，Gowin 云源软件还未提供仿真文件，IP 目录结构以实际 IP Core 生成为准。 

图 3-4 MIPI RX IP 目录 

 

 

在 IP Core Generator 界面中，双击 MIPI TX 打开 IP Customization 界

面，根据需要选择配置，本设计 MIPI TX 配置如图 3-5 所示，完成配置选择

之后，点击“OK”，即可生成 MIPI TX 的 IP。 

图 3-5 MIPI TX 配置 

 

 

MIPI RX 和 MIPI TX 的 IP 生成之后，在 Design 窗口的显示如图 3-6 所

示。 
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图 3-6 Design 窗口显示 

 

3.1.3 加载文件 

为测试 MIPI RX 和 MIPI TX 的功能，需新建或加载一些功能设计文件，

完成之后，Design 窗口如图 3-7 所示。 

图 3-7 加载文件 

  

3.1.4 查看 RTL 原理图 

源文件加载完成后，可通过菜单栏“Tools > Schemetic Viewer”查看整
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个设计的原理图，帮助用户更好了解整个设计的逻辑构成。Schemetic Viewer

的详细使用方法请参考 SUG100，Gowin 云源软件用户指南。 

3.2 GowinSynthesis 综合 

3.2.1 参数配置 

选择“Process > Synthesize > Configuration”，弹出 Configurations 对

话框，在此对话框进行综合参数配置，关于 GowinSynthesis 所有配置的详

细说明，可参考具体可参考 SUG550，GowinSynthesis 用户指南。 

本设计选择 GowinSynthesis 工具进行综合，TOP Module/Entity 设为

DPHY_TOP，如图 3-8 所示。 

图 3-8 综合参数配置 

 

 

此外，也可以通过在源文件中添加一些综合属性和指令控制综合结果，

关于属性和指令的详细说明，可参考 SUG550，GowinSynthesis 用户指南。

如图 3-9 所示，本设计中，使用/* synthesis syn_keep=1 */综合属性，在综

合和优化过程中，将特定 net 进行保留而不被优化。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
http://cdn.gowinsemi.com.cn/SUG550.pdf
http://cdn.gowinsemi.com.cn/SUG550.pdf
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图 3-9 Synplify Pro 的属性和指令 

 

3.2.2 综合 

完成综合参数配置之后，即可进行综合。 

双击 Process 窗口中的 Synthesize，开始进行综合，综合完成后，如图

3-10 所示，Synthesize 前面的图标变为“ ”，可双击 Synthesis Report

查看综合报告，双击 Netlist File 查看综合后网表文件。 

图 3-10 综合完成界面 

 

 

综合完成后，在工程创建路径\impl 下生成 gwsynthesis 文件夹，该文件

夹包含综合过程生成的所有文件，如图 3-11 所示。 
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图 3-11 gwsynthesis 目录 

注！ 

如果有�Synplify Pro license，使用�Synplify Pro 进行综合，综合完成之后，在工程创建路径

\impl下生成�synthesize 文件夹，该文件夹用于放置综合过程生成的所有文件及文件夹。 

3.3 物理约束 

完成综合之后，可通过手动书写或 FloorPlanner 工具编辑物理约束，本

设计使用 FloorPlanner 工具编辑物理约束。该工具的详细使用方法请参考 

SUG935，Gowin 设计物理约束指南。 

3.3.1 新建物理约束 

选择 Gowin 云源软件“Process > User Constraints > FloorPlanner”，

打开 FloorPlanner 工具，该工具支持 I/O、Primitive、Group 等物理约束。

本设计只添加 I/O 约束，并以此为例。 

约束编辑窗口中的 I/O 约束窗口，可创建 I/O Constrains。在 Netlist 窗

口或 I/O Constraints 窗口中选中预约束 Port 的所在行拖拽到 Package View

或 Chip Array 视图中的具体位置上，完成后，预约束 port 的 Location 信息

变为拖拽到的 IOB 的位置，如图 3-12 所示。 

http://cdn.gowinsemi.com.cn/SUG935.pdf
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图 3-12 I/O 约束 

 

 

完成所有约束编辑后，单击工具栏的“Save”，生成物理约束文件，物

理约束文件在 Design 窗口和源文件编辑区的显示如图 3-13 所示。 
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图 3-13 物理约束显示 

 
 

在布局布线阶段，如果没有物理约束文件，会自动布局布线；如果有物

理约束文件，会根据物理约束文件进行布局布线。 

3.3.2 修改物理约束 

生成物理约束文件后，可通过 FloorPlanner 工具对物理约束进行修改，

修改完成后，单击工具栏的“Save”，即可完成约束修改。  

3.4 时序约束 

完成综合之后，可通过手动书写或 Timing Constraints Editor 工具编辑

时序约束，本设计使用时序约束编辑器工具编辑时序约束。该工具的详细使

用方法请参考 SUG101，Gowin 设计时序约束指南。 

3.4.1 新建时序约束 

选择 Gowin 云源软件“Process > User Constraints > Timing Constrains 

Editor”，打开 Timing Constrains Editor 工具，该工具支持时钟、I/O、时序

报告等时序约束。本设计添加时钟、时序报告约束，以此为例。 

时钟约束 

选中 Timing Constraints 下的 Clocks，在右侧空白处，右键单击选择

Create Clock，弹出 Create Clock 对话框，如图 3-14 所示，创建如下约束： 

 Clock name：clk_rx 

 Period：10 

http://cdn.gowinsemi.com.cn/SUG101.pdf
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 Rising：0 

 Falling：5 

 Source Object：get_pins 

{u_DPHY_RX_TOP/DPHY_RX_INST/u_idesx8/Inst3_CLKDIV/CLKOU
T} 

图 3-14 Clock 约束 

 

 

时序报告约束 

选中“Timing Constraints > Report > Report Timing”，在右侧空白处，

右键单击选择 Create Report，在弹出的 Report Timing 对话框中设置参数，

报告 clk_rx to clk_rx 的 setup 路径，路径条数限制 100，如图 3-15 所示。 
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图 3-15 时序报告约束 

 

 

完成所有约束编辑后，单击工具栏的“Save”，生成时序约束，时序约

束在 Design 窗口和源文件编辑区的显示如图 3-16 所示。 

图 3-16 时序约束显示 

 
 

在布局布线阶段，如果没有时序约束文件，会按照默认时钟进行时序分

析；如果有时序约束文件，会根据时序约束文件进行时序分析。 

3.4.2 修改时序约束 

生成时序约束文件后，可通过 Timing Constrains Editor 工具对时序约束

进行修改，修改完成后，单击工具栏的“Save”，即可完成约束修改。 
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3.5 GAO 配置 

完成综合之后，可创建 GAO 配置文件，用于采集数据，验证设计的正

确性。Gowin 云源软件提供 Standard Mode GAO 和 Lite Mode GAO，GAO

工具的详细使用方法请参考 SUG114，Gowin 在线逻辑分析仪用户指南。 

本设计采用 Standard Mode GAO，并以此为例。 

3.5.1 新建 Standard Mode GAO 配置文件 

选择 Gowin 云源软件的“Design > New File„”，在弹出的 New 对话框

中，选择新建一个 GAO Config File，如图 3-17 所示。单击“OK”，Type 选

择 For Post-Synthesis Netlist，Mode 选择 Standard，单击“Next”，文件名

定义为 MIPI_RX_TX，单击“Next”，直至 Standard Mode GAO 配置文件创

建完成。 

图 3-17 新建 GAO 配置文件 

 

3.5.2 配置 Standard Mode GAO 

完成 Standard Mode GAO 配置文件创建后，进行配置功能内核数量、

触发选项和采样选项。触发选项包括触发条件、触发端口、匹配单元和触发

表达式；采样选项包括采样信号、存储信息、采样数据信号。本设计功能内

核数量为 1，触发选项配置如图 3-18 所示，采样选项配置如图 3-19 所示。 

http://cdn.gowinsemi.com.cn/SUG114.pdf
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图 3-18 触发选项配置 

 

 

图 3-19 采样选项配置 

 

 

完成所有选项配置后，单击工具栏的“Save”，即完成 Standard Mode 

GAO 配置文件，GAO 配置文件在 Design 窗口的显示如图 3-20 所示。 
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图 3-20 GAO 配置文件显示 

 

3.6 GPA 配置 
完成综合之后，可创建 GPA 配置文件，用于功耗分析，帮助用户分析系

统功耗。GPA 功耗分析工具的详细使用方法请参考 SUG282，Gowin 功耗分

析工具用户指南。 

3.6.1 新建 GPA 配置文件 

选择 Gowin 云源软件的“Design > New File„”，在弹出的 New 对话框

中，选择新建一个“GPA Config File”，如图 3-21 所示。单击“OK”，文件

名定义为MIPI_RX_TX，文件路径默认选择该工程下的src文件夹，单击“OK”，

GPA 文件创建完成。 

http://cdn.gowinsemi.com.cn/SUG282.pdf
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图 3-21 新建 GPA 配置文件 

 

3.6.2 配置 GPA 

完成 GPA 配置文件创建后，进行配置 General Setting、Rate Setting

和 Clock Setting。 

 General Setting 包括芯片、封装、速度等级和配置温度等级、热阻抗、

电压等特性参数； 

 Rate Setting 用于信号翻转率的设置，可直接对 IO 或 Net 设置翻转率，

也可以采用默认翻转； 

 Clock Setting 主要用于配置工作时钟以及 B-SRAM、I/O 和 DFF 时钟的

工作使能特性。 

General Setting 

本设计 General Setting 配置为 COMMERCIAL 温度等级，环境温度选

择 25℃，无散热片装置，辅助电压设为 3.3V，内核电压设为 1.2V，如图 3-22

所示。 
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图 3-22 General Setting 配置 

 

 

Rate Setting 

本设计中时钟信号 clkx2 和 clkx2x4 翻转率为 50%，其余信号翻转率为

全局默认翻转率 12.5%，如图 3-23 所示。 
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图 3-23 Rate Setting 配置 

 

 

Clock Setting 

本设计 Clock 为时序分析中创建的时钟，B-SRAM 中指定了本设计所用

的 pROM 的时钟使能和读取使能，其余未设置，如图 3-24 所示。 
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图 3-24 Clock Setting 配置 

 

 

完成所有选项配置后，单击工具栏的“Save”，即完成 GPA 配置文件，

GPA 配置文件在 Design 窗口的显示如图 3-25 所示。 
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图 3-25 GPA 配置文件显示 

 

 

在布局布线阶段，如果没有 GPA 配置文件，会按照默认配置进行功耗分

析；如果有 GPA 配置文件，会根据 GPA 配置文件进行功耗分析。 

3.7 布局布线 

完成综合并根据用户需求创建物理约束文件、时序约束文件、GAO 配置

文件以及 GPA 文件之后，即可开始布局布线。 

3.7.1 参数配置 

选择“Process > Place & Route > Configuration”，弹出 Configurations

对话框，在此对话框进行 General、Dual-Purpose 和 Bitstream 参数配置，

参数配置的详细说明请参考 SUG100，Gowin 云源软件用户指南。 

本设计布局布线参数配置，如图 3-26 所示，将 Generate SDF File、

Generate Post-Place File、Generate Post-PNR Simulation Model File 配置

为 True，Place input register to IOB、Place output register to IOB、Place 

inout register to IOB 配置为 False，其余参数采用默认配置。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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图 3-26 布局布线参数配置 

 

3.7.2 运行 PnR 

完成布局布线参数配置之后，即可进行布局布线。 

双击 Process 窗口中的 Place & Route，开始进行布局布线，布局布线

时会根据物理约束进行布局布线，根据时序约束进行时序分析，根据 GAO

配置进行 GAO 的布局布线，根据 GPA 配置进行功耗分析。布局布线完成后，

如图 3-27 所示，Place & Route 前面的图标变为“ ”。 
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图 3-27 布局布线完成界面 

 

 

布局布线完成后，在工程创建路径\impl 下生成 pnr 文件夹，如图 3-28

所示，该文件夹包含布局布线过程生成的所有文件，包括比特流文件、布局

布线后网表文件及输出报告等。其中，布局布线报告、端口属性报告、时序

报告和功耗分析报告的详细信息参考 3.11 输出文件。 

图 3-28 pnr 目录 
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如果工程中包含 GAO 配置文件，布局布线完成后，在工程创建路径\impl

下生成 gao 文件夹，如图 3-29 所示： 

 ao_0 包含功能内核的参数文件和综合结果； 

 ao_control 包含控制内核的参数文件和综合结果； 

 gao.v 为 GAO 综合后网表文件，其为加密形式。 

图 3-29 gao 目录 

 

3.8 时序优化 

完成布局布线之后，可以通过 FloorPlanner 工具修改物理约束或关键路

径，帮助用户实现时序收敛，从而达到优化时序的目的。该工具的详细使用

方法请参考 SUG935，Gowin 设计物理约束指南。 

使用 FloorPlanner 进行时序优化，需要布局信息文件和时序路径信息文

件，这两个文件在布局布线阶段会自动产生。 

3.8.1 时序分析 

布局布线之后，会生成时序报告，通过查看时序报告，如果最大频率不

满足设计需求，如图 3-30 所示，clk_tx 的最大频率不满足设计需求，可通过

FloorPlanner 进行时序优化。 

图 3-30 时序报告最大频率 

 

3.8.2 调整关键路径 

启动FloorPlanner工具，会自动加载布局信息文件和时序路径信息文件，

加载完成后，Netlist 窗口 Timing Path 的 Setup 和 Hold 显示如图 3-31 所示。

将 Chip Array 视图修改为 Show Place View > All Instance，即可高亮某条路

径，如图 3-32 所示。 

http://cdn.gowinsemi.com.cn/SUG935.pdf


3 快速入门 3.8 时序优化 

 

SUG918-1.1.1 26(36) 

 

图 3-31 时序路径显示 
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图 3-32 路径高亮显示 

 

 

调整后的路径如图 3-33 所示，调整完成后，单击工具栏的“Save”，即

可完成约束修改。经此调整后，如果最大频率仍不满足设计需求，可继续进

行时序优化。 

图 3-33 调整后路径显示 

 

3.9 比特流下载 

通过时序优化调整布局使得设计满足时序需求之后，重新布局布线，生

成比特流文件，通过 Programmer 工具进行比特流下载，验证设计的正确性。

该工具的详细使用方法请参考 SUG502，Gowin Programmer 用户指南。 

选择“Process > Program Device”，打开 Programmer 工具，该工具自

http://cdn.gowinsemi.com.cn/SUG502.pdf
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动识别加载该工程的比特流文件。开发板准备就绪之后，单击工具栏的

Program/Configure 图标，即可下载比特流到开发板，比特流下载完成之后，

如图 3-34 所示。 

图 3-34 Programmer 界面 

 

3.10 GAO 采集数据 

完成比特流下载之后，可以通过 GAO 工具验证设计的正确性，GAO 工

具的详细使用方法请参考 SUG114，Gowin 在线逻辑分析仪用户指南。 

单击 Gowin 云源软件工具栏的 Gowin Analyzer Oscilloscope 图标，打

开 GAO 显示界面，该工具自动识别加载该工程的 GAO 配置文件，如图 3-35

所示。 

图 3-35 GAO 显示界面 

 

http://cdn.gowinsemi.com.cn/SUG114.pdf
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单击 GAO 显示界面的 Start 图标，开始采集数据，采集完成之后，GAO

显示界面生成 windows 窗口用于显示波形，如图 3-36 所示，该窗口支持游

标标记位置信息、波形放大缩小等操作，方便用户分析数据的正确性。 

图 3-36 GAO 波形显示 

 

3.11 输出文件 

3.11.1 布局布线报告 

布局布线报告，列出了用户设计占用的芯片资源信息、内存消耗信息、

时间消耗信息等，方便用户了解设计的大小及与目标芯片是否匹配等内容。

文件后缀名为.rpt.html，具体信息可查看*.rpt.html 文件。 

用户可在 Process 窗口中的 Place & Route 区，双击“Place & Route 

Report”，打开布局布线报告，如图 3-37 所示。 

有关布局布线报告的详细信息，请参考 SUG100，Gowin 云源软件用户

指南。 

图 3-37 布局布线报告 

 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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3.11.2 端口属性报告 

端口属性报告，是在布局之后输出的端口属性的文件，包括端口的类型、

属性及端口位置信息等，生成的文件后缀名为.pin.html，具体信息可查看

*.pin.html 文件。 

用户可在 Process 窗口中的 Place & Route 区，双击“Ports & Pins 

Report”，打开端口属性报告，如图 3-38 所示。 

有关端口属性报告的详细信息，请参考 SUG100，Gowin 云源软件用户

指南。 

图 3-38 端口属性报告 

 

3.11.3 时序报告 

时序报告输出提供两种类型的时序报告：网页格式和文本格式，默认为

网页格式。 

时序报告包括建立时间检查、保持时间检查、恢复时间检查、移除时间

检查、最小时钟脉冲检查、最大扇出路径、布线拥塞度报告等部分，默认情

况下对上述所有检查进行报告，并提供最大频率的报告。 

用户可在 Process 窗口中的 Place & Route 区，双击“Timing Analysis 

Report”，打开时序报告，如图 3-39 所示。 

有关时序报告的详细信息，请参考SUG940，Gowin 设计时序约束指南。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
http://cdn.gowinsemi.com.cn/SUG940.pdf
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图 3-39 时序报告 

 

3.11.4 功耗分析报告 

功耗分析报告主要是针对用户设计，根据器件的特性做一个预估的功耗

计算，帮助用户评估设计的基本功耗值。 

用户可在 Process 窗口中的 Place & Route 区，双击“Power Analysis 

Report”，可打开功耗分析报告，如图 3-40 所示。 

有关功耗分析报告的详细信息，请参考 SUG282，Gowin 功耗分析工具

用户指南。 

图 3-40 功耗分析报告 

 

3.12 文件加密 

3.12.1 源文件加密 

当用户需要加密保护源文件时，可以在建立工程后，通过 Hierarchy 窗

口对所选 module 及其 sub module 进行加密，如图 3-41 所示。其详细使用

方法请参考 SUG100，Gowin 云源软件用户指南。 

http://cdn.gowinsemi.com.cn/SUG282.pdf
http://cdn.gowinsemi.com.cn/SUG100.pdf


3 快速入门 3.12 文件加密 

 

SUG918-1.1.1 32(36) 

 

图 3-41 Hierarchy 窗口信息显示 

 
 

以 module DPHY_TOP 为例介绍文件加密方法。 

在 Hierarchy 窗口中右键单击 DPHY_TOP，选择右键列表中的“Pack 

User Design”，打开文件加密窗口，如图 3-42 所示。 

图 3-42 Pack User Design 窗口  
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综合工具选择 GowinSynthesis，module 为 DPHY_TOP，点击“Pack”

开始执行加密，开始加密及加密成功后会在 Output 窗口打印相关信息。 

加密完成后在目标路径(E:\IDE\MIPI_RX_TX\src\DPHY_TOP_pack)下

生成两个文件：DPHY_TOP_gowin.vp 和 DPHY_TOP_sim.v。 

 DPHY_TOP_gowin.vp 为加密文件，可提供给他人使用； 

 DPHY_TOP_sim.v 是打平的综合后明文网表文件，可以用于仿真。 

3.12.2 仿真文件加密 

高云提供的仿真文件是明文格式，为了进一步保护仿真文件，可将仿真

文件使用第三方仿真软件进行加密，以 modelsim 和 vcs 仿真工具对

DPHY_TOP_sim.v 加密为例进行介绍。 

Modelsim 仿真工具加密 

使用 modelsim 仿真时，将仿真文件进行加密，可通过以下步骤： 

1. 在仿真文件 DPHY_TOP_sim.v 中需要加密的内容前后分别添加宏定义

`protect 和`endprotect； 

2. 运行命令：vlog +protect DPHY_TOP_sim.v； 

3. 执行完命令，会在 work 库生成 DPHY_TOP_sim.vp，该文件为

DPHY_TOP_sim.v 加密后文件，可用于 modelsim 仿真。 

vcs 仿真工具加密 

使用 vcs 仿真时，将仿真文件进行加密，可通过以下步骤： 

1. 在仿真文件 DPHY_TOP_sim.v 中需要加密的内容前后分别添加宏定义

`protect128 和`endprotect128； 

2. 运行命令：vcs +v2k -protect128 DPHY_TOP_sim.v； 

3. 执行完命令，会在当前路径下生成 DPHY_TOP_sim.vp，该文件为

DPHY_TOP_sim.v 加密后文件，可用于 vcs 仿真。  
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4 Tcl 命令使用 

前面介绍采用界面操作实现整个设计流程的方式，云源软件还提供了 tcl

命令实现一些设置和流程，以 MIPI 设计为例介绍 tcl 命令的使用，tcl 命令的

详细介绍请参考 SUG100，Gowin 云源软件用户指南附录 A。 

4.1 Tcl 命令编辑窗口 

在 Console 信息输出页的最下方是 tcl 命令编辑窗口，可以在窗口中输

入 tcl 命令后通过回车键来执行相关命令，如图 4-1 所示。 

图 4-1 tcl 命令编辑窗口 

 

4.2 Tcl 命令快速入门 

4.2.1 rm_file 

rm_file 用于移除设计文件。为介绍该命令的使用，将工程中功能设计文

件 ROM549X17.v 和 DPHY_TOP.v 移除该工程，用 tcl 命令实现如下： 

同时移除 ROM549X17.v 和 DPHY_TOP.v 

rm_file src/ROM549X17.v src/DPHY_TOP.v 

执行完该命令，console 窗口会显示移除文件的提示信息，两个文件不

显示在 design 窗口。 

4.2.2 add_file 

add_file 用于添加设计文件。为介绍该命令的使用，将被移除的功能设

计文件 ROM549X17.v 和 DPHY_TOP.v 重新添加到工程，用 tcl 命令实现如

下： 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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同时添加 ROM549X17.v 和 DPHY_TOP.v 

add_file src/ROM549X17.v src/DPHY_TOP.v 

执行完该命令，console 窗口会显示添加文件的提示信息，两个文件显

示在 design 窗口。 

4.2.3 set_file_enable 

set_file_enable 用于设置文件是否可以被使用。为介绍该命令的使用，

先将设计中的 DPHY_TOP.v 修改为 disable 状态，然后再将其改为 enable

状态，用 tcl 命令实现如下： 

将 DPHY_TOP.v 修改为 disable 状态 

set_file_enable src/DPHY_TOP.v false 

执行完该命令后，console 窗口会显示 disable 文件的提示信息，design

窗口 DPHY_TOP.v 文件被置灰。 

将 DPHY_TOP.v 修改为 enable 状态 

set_file_enable src/DPHY_TOP.v true 

执行完该命令后，console 窗口会显示 enable 文件的提示信息，design

窗口 DPHY_TOP.v 文件显示为可用状态。 

4.2.4 set_option 

set_option 用于设置工程相关的属性配置及流程选项。本设计中的综合

和布局布线的参数配置，用 tcl 命令实现如下： 

 综合工具选择 GowinSynthesis 

set_option -synthesis_tool gowinsynthesis 

 TOP Module/Entity 设为 DPHY_TOP 

set_option -top_module DPHY_TOP 

 Generate SDF File 配置为 True 

set_option -gen_sdf 1 

 Generate Post-Place File 配置为 True 

set_option -gen_posp 1 

 Generate Post-PNR Simulation Model File 配置为 True 

set_option -gen_sim_netlist 1 

 Place input register to IOB 配置为 False 

set_option -ireg_in_iob 0 

 Place output register to IOB 配置为 False 

set_option -oreg_in_iob 0 

 Place inout register to IOB 配置为 False 

set_option -ioreg_in_iob 0 
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4.2.5 run 

run 用于运行全部流程或某个流程。本设计执行综合和布局布线流程，

用 tcl 命令实现如下： 

 执行综合 

run syn 

 执行布局布线 

run pnr 

4.2.6 set_device 

set_device 可用于设置目标器件。将本设计移植到 GW1N-9C， 

GW1N-LV9PG256C6/I5，用 tcl 命令实现如下： 

将目标器件修改为 GW1N-9C，GW1N-LV9PG256C6/I5 

set_device -name GW1N-9C GW1N-LV9PG256C6/I5 

执行完该命令，在 console 窗口会显示当前的 device 信息。 

4.2.7 saveto 

saveto 用于将当前工程设计数据保存到 tcl 脚本，包括当前的器件信息、

设计文件和流程选项等信息。将本设计的数据保存为 mipi.tcl，可供之后用命

令行模式运行，用 tcl 命令实现如下： 

将当前工程设计数据保存到 mipi.tcl 

saveto mipi.tcl 

执行完该命令，会在工程文件所在路径生成 mipi.tcl 文件。
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